
Movie Timeline Plugin v2.0 User Guide  
Overview  
The Movie Timeline Plugin helps users record animations from STK. It provides a movie wizard, and a graphical 
timeline showing STK scenario time. In addition to movies, the timeline also allows users to visualize certain data 
providers and access intervals on the timeline, and to design 3D model articulations on the timeline.  

What's New  
The new version 2.0 extends the timeline's functionality beyond just movies. STK's data providers and access intervals 
can now be visualized on the timeline. Additionally, 3D model articulations can be created, imported, and edited directly 
on the timeline. For details on these new features, see the section on Adding Object Timelines later in this 
documentation.  

Getting Started  
Start by opening a scenario in STK. Turn on the Movie Timeline toolbar, if it is not already visible.  

  

Click on the "View" menu, and look for a menu option called View->Toolbars->Movie Timeline. If this option is in the 
menu, but there is no checkmark next to it, select it from the menu to turn on the Movie Timeline toolbar. If the toolbar 
isn't mentioned in the View->Toolbars menu, see Troubleshooting.  

  

The toolbar has eight buttons, most with a gray filmstrip across the bottom. The left-most button has a blue knob on it, 
and if you hover over it, the tooltip should say "Open the Movie Timeline".  

Click the leftmost button to open the timeline window. Since this is the first time the window has opened for this 



scenario, a two-page wizard will pop up to ask some questions about the nature of the timeline being created.  

  

The first page asks which STK window is being recorded from.  

  

The second page asks for your first guess at the length of the movie being created. If you don't know the answer to the 
second page, just accept the defaults, and there will be many opportunities to edit and review the animation settings 
before recording your first movie with this plugin.  

  

After completing the wizard, the main timeline is displayed. There are a number of interactive elements on the timeline 
window.  

l Click and drag anywhere in the white bar with the tic marks to control STK scenario time.  



l Drag the green or red handles at either end of the timeline to control when the movie begins and ends. Position the 
start and end times to surround the action of interest in your scenario.  

l Zoom in or out on the timeline by clicking the magnifying glass icons at the bottom left. For a smoother zoom, 
select the desired direction (+ for zoom in, - for zoom out), and click and drag the desired button to the right.  

l When zoomed in, the blue bar at the bottom indicates relative position, and can be manipulated with the mouse. 
The left and right arrows on either end can be clicked and dragged for smooth scrolling.  

l Click and drag the thin bar just to the left of the white timecode track, to adjust the width of the header block, 
revealing longer track names that may be written there. This is primarily useful for object tracks, described later in 
this documentation.  

 The Eyeball icon  
The eyeball icon appears on a movie track just to the left of the collapse triangle in the header box. It indicates the 
currently "watched" movie, the one that will send time step and camera change information to STK during animation. 
The most recently selected movie is the "watched" movie. The movie can continue to be "watched" even while selecting 
and editing non-movie tracks, such as items on an object timeline.  

To turn off a "watched" movie, click the small triangle next to the eyeball, to collapse the movie track. The movie will no 
longer send time step or camera information to STK while collapsed.  

Units    
The times displayed on the timeline are shown using DateFormat units, as set in your scenario basic properties, units 
page. If you change the DateFormat unit setting in STK, you will likely have to click  Reset to see the change take 
effect on the timeline.  

There are two buttons on the toolbar that can be used as shortcuts, to rapidly change the DateFormat units to one of the 
two types commonly used in STK movie making:  Gregorian UTC, and  Epoch Seconds. Click either of these 
buttons to immediately set the displayed units both on the timeline and on STK's user interface.  

Setting up camera views  
The Movie Timeline can make animations that switch between multiple 3D camera views. There are two main types of 
3D camera views supported: Stored Views and Camera Paths. For 2D windows, there are Map Styles.  

 Stored Views (3D)  

Stored views are simple to create, and allow the camera to sit in place and watch the action unfold. To create one, find the 
intended view in your 3D graphics window, and then click the Stored View toolbar button. A small window will open 
with a list of Stored Views. Click the "New" button to create a view. Finally, click on the name of your new view (the 
default name is "view0"), and rename it to a name that makes sense to you, or describes the object or action visible in the 
view.  

 Camera Paths (3D)  

Camera Paths are a little trickier to create, but can be worth the effort. Click the camera path icon, then click the "Help" 
button in the lower-right corner of the window that opens. Read the section on "How to... Create a camera path".  

 Map Styles (2D)  

These are similar to Stored Views in 3D, in that they define a viewing area of interest, but they also include information 



about which 2D graphics options are turned on. Currently it is not possible to change Map Styles in the middle of a 
movie.  

Using camera views  
After setting up one or more camera views, you may assign them to become 
active at specific times during your movie. To do so, find the desired time 
using either the classic animation controls, or by clicking and dragging the 
white bar with time tic marks at the top of Movie Timeline. Click the spot 
where the "Camera" track and the red line intersect, and pick the desired 
camera view. 

Adjusting the playback speed  
Sometimes, different camera views call for different playback rates. For 
example, a Mars mission might need a fast playback rate during its cruise 
phase, and a slower playback rate during the aerobraking phase. To handle this, 
different time step sizes can be placed on the timeline in a manner similar to 
the camera views. Click the spot where the time step track intersects the red 
line, and choose a new time step size. 

Previewing your movie  
There are two similar but different ways to preview the movie before recording. These are represented by two "Play" 
buttons on the toolbar. It's best to try both kinds of preview at least once before recording a movie. For simple scenarios, 
you may not notice a difference between the two. This is good because it means the preview should be accurate. If the 
two types of previews differ, the final movie should combine the content from one preview with the playback speed of 
the other preview.  

 Play all frames  

The play button on the left will play your movie using "Normal" animation mode, which will show each frame of 
animation as fast as your computer can render it. The rate you see here may be faster or slower than the playback rate of a 
recorded movie, depending on the performance of your computer's graphics card. This mode is good for previewing 
frame-dependent effects like pulsing sensors.  

 Play emulating speed  

The play button on the right has a little yellow clock on it, and uses a special mode called "XRealTime" in STK to 
emulate the proper playback rate of a recorded movie. If your graphics card performance is low, frames of animation may 
be dropped from this preview, to keep up the playback rate. If your graphics card performance is high, it is possible that 
additional frames will be added, to maintain the desired rate. This preview mode is the preferred mode when you're trying 
to get an idea of how fast the action will unfold for viewers watching your movie.  

 Recording your movie  



When you record a movie, it will always record in "Normal" mode, capturing each frame regardless of computer 
performance, and regardless of the last preview mode used. You can expect it to play back at a fixed rate on any system 
capable of properly playing the movie.  

Start by clicking the round red "Rec" button, either from the Timeline window or from the toolbar. The movie recording 
wizard opens up again, this time with seven pages (some of which you've already seen) detailing all the options that 
affect the recording of your movie.  

Filename & Format  

  

Start by selecting a filename for your movie. You can leave the format set to the default, Windows Media Video, unless 
you have a specific need for another format.  

Window  

The second page asks you to confirm which window is being recorded.  

Resolution  

  

Here you can set the resolution of your movie, which is how large it will appear on screen. Many movie formats require 
these numbers to be evenly divisible by 8 or 16. It's best to pick one of the presets from the pull-down menu if you're not 
sure. If you see error messages during this stage, check to make sure that your graphics window is not minimized, 
maximized, or docked. On most systems, the graphics window is also prevented from growing larger than the desktop. 
For example, if you ask for HDTV 1080p while using a 1280x1024 monitor, you may get an error message, because the 
window would be too big to fit on the screen (This is an intentional limitation within Microsoft Windows, to protect 



general usability of the system). If this happens, pick a smaller size, or use a higher resolution screen. If you get errors 
even with smaller window sizes, dismiss the wizard altogether, and make sure your graphics window is un-docked and 
un-maximized, then use the "Rec" button to get back into the wizard.  

Camera  

The next page, "Camera," asks you to choose a camera view if you have not already done so. This can be a stored view, a 
camera path, or a map style (in the case of a 2D window). If you have already placed multiple camera views on your 
timeline, this page will be grayed out, just click the "Next" button to move on.  

Time & Length  

  

This page is a repeat of one of the pages you saw back when you first created your timeline. If you have made changes to 
the start or end points on the timeline, or the time step sizes used, those changes will be reflected on this page.  

Take a look at the small padlock icon. When there is a checkmark here, changes made to either of the top two sliders will 
affect the other slider, and "End Time" will remain unchanged. If you remove this checkmark, changes made to either 
slider will affect the End Time directly.  

The two sliders represent the rate of playback and length of playback, respectively. Together, they dictate that a certain 
amount of scenario time will play out during the allotted movie playback time. Typically, if you have already used the 
timeline start and end markers (the green and red handles on either end of the timeline) to frame the action of interest in 
your movie, then you will want to leave the padlock checkmark turned on, leaving your desired start and end time locked 
in place, and use the sliders to strike a balance between play speed and movie length.  

NOTE: You can click "Preview speed" and then adjust the playback rate while the movie is actively being previewed. 
This provides a highly interactive method for experimenting with different playback rates. 

Size & Quality  



  

There are two basic ways to affect the image quality in your movie: How much time you're willing to spend rendering 
(creating) the movie, and how much disk space you're willing to devote to the finished product.  

The top half of this page governs the render quality. Cranking up the anti-aliasing setting will make your system spend 
more time creating a movie with smoother edges and cleaner images and textures. For a draft rendering, turn this off. But 
if you have the time to spend on this, it is highly recommended to crank it up to 4x4. It might even save you some disk 
space: Without anti-aliasing, your video may contain "aliasing artifacts" such as rough edges and flickering texturemaps, 
which the video encoder may attempt to preserve on disk. A smoother, anti-aliased image will be stored more easily.  

The bottom half of this page affects the size of the movie file on disk. If you're using Windows Media (the default, from 
the first page), then you have a lot of flexibility here. You can pick one of the quality presets (High, Medium, Low, etc) 
from the pull-down menu, and see an estimate of how large the movie might get. Or, you can type in the desired 
maximum size into the box, and the wizard will compute a corresponding "bitrate" (the amount of disk space used per 
second of movie playback) that can be given to Windows Media Encoder to target a specific file size. Note that if you 
have a lot of black space or solid color in your movie, the actual file size may be substantially less than the estimated 
size.  

Record  

  

The final page offers a summary of the selected settings, one last chance to preview the movie, and the option to begin 
recording. Once recording is underway, the main record button changes to an abort button.  



  

If the recording completes successfully, a simple question is posed.  

  

If you answer "Yes", Movie Timeline will have your system play the recorded movie using the movie playing software 
that is registered as the default for that type of file. Typically, this would be Windows Media Player on most systems.  

Save and Load  
Save and load happens automatically when you save or load a scenario in STK. The save file has the same base filename 
as the scenario file, but has a file extension of .mtline instead of .sc. The data is saved in XML format, and is not 
meant to be hand-edited.  

Import and Export    

Most users will never need to click the  Import or  Export buttons. These buttons are for people who need to migrate 
a Movie Timeline from one scenario to another, or are trying to manage multiple versions of a timeline for one scenario. 
They allow you to save and load the state of the timeline independently from the STK scenario. The same .mtline file 
format is used.  

Adding Object Timelines  
Object timelines are used to represent STK scenario objects on the timeline. They can display time intervals from data 
providers, access intervals, and 3D model articulations.  

To create an object timeline, right-click any STK object (other than the scenario itself) in the STK object browser 
window, or in one of the 3D windows (note that "selection" must be enabled in the 3D window for right-clicking an 
object to work there). A context menu should appear, displaying a list menu options specific to the clicked object. From 
this menu, pick "Plugins -> Add Object Timeline."  



  

A dialog box will appear, showing a tree of items that are available to be added to the timeline, on the left, and a list of 
added items on the right.  

  

Any of the items on the left can be moved to the right by selecting it and clicking the right-arrow button. Items can be 
removed by selecting them on the right and clicking the left-arrow icon. None of the changes made here will take effect 
until the "OK" or "Apply" button is clicked.  

When adding multiple items at once, multi-select is not available in a tree view such as the left side of this window, 
however, a shortcut is to simply double-click on each item of interest, rather than using the right-arrow icon. For model 
articulations, a parent folder in the tree containing multiple articulations can be selected and moved to the right with one 
click.  

You can bring back this dialog for an existing object timeline by selecting the timeline (click the object name at the top 
on the left side) and then clicking the yellow "properties" folder above the timeline. Likewise, you can delete an object 
timeline, or an individual track within the timeline, or an individual articulation keyframe within a track, by selecting the 
target item and clicking the red "X" icon above the timeline.  

Three main types of items are available to add to object timelines: data providers, access intervals, and model 
articulations.  

 Data providers  

Data providers are used to create reports and graphs in STK. Only a subset of STK's data providers may be shown on the 



timeline, specifically ones that return time intervals. In addition to any data providers you manually select, the timeline 
will automatically use the "Available Times" data provider to determine the start and end times of the object timeline 
itself.  

 Access intervals  

Access intervals work similarly to data providers, displaying available access between two STK objects. Select one and 
click the right-arrow icon, or just double-click the item in the left window, to move it to the right, for inclusion on the 
timeline. If the access has already been computed in STK, it will be used on the timeline, otherwise a question will pop 
up after clicking "OK" for confirmation that the access should be computed when the timeline is created.  

  

Answering "OK" here will cause STK to compute the access in the scenario, and the resulting time intervals will be 
shown on the object timeline.  

 Model articulations  

If any model articulations have been added to the timeline, or if the right-hand list has been left completely empty and 
some model articulations exist in a file on disk, then you may see a variation of the following dialog.  

  

There are potentially two questions to resolve here, and the default answer to both is yes. The first is the question of 
whether the timeline should import existing model articulations from disk. The exact filename to be used for import will 
be shown in the text area of the above dialog. Skipping this import could cause the model to lose pre-existing 
articulations.  

The second question will only appear if your model has STK's default setting called "Do not save articulation file". This 
setting is intended to prevent STK from automatically rewriting a hand-made articulation file on disk. The timeline is 
asking your permission to turn this setting off, thus allowing STK to overwrite the file the next time the scenario is saved. 
This is important for the timeline to be able to save model articulations such that they reload automatically even on 
systems where the timeline is not installed, including compatibility with AGI Viewer VDF files. If you have previously 
created an articulation file by hand, or using some other tool, you should make a backup of the file before allowing this 
setting to be changed.  

Having made a backup of any pre-existing model articulation file, you can now accept the default "yes" answer to both of 
these questions.  

Editing the object timeline  



Once the above is complete, an object timeline will appear, similar to the following.  

 

The data providers and access intervals cannot be directly edited on the timeline, as they are built from STK output data. 
Changing your object settings in STK should cause these tracks to update.  

The 3D model articulations, however, can be created, deleted, and edited on the timeline. To create one, position the 
scrub bar (the vertical red line representing current STK time) on the desired start time for your articulation. Then, hover 
over the spot on the articulation track where the red line crosses it. The mouse pointer here should change to the "add 
keyframe" pointer, a small diamond with a plus sign inside. Click this spot to create a model articulation here. The 
keyframe editor dialog, below, will appear.  

To move a keyframe to a new start time, drag it with the left mouse button, from anywhere in the middle of the keyframe. 
The edges of the keyframe, shown above as small blue triangles, can be dragged individually, to adjust the duration of the 
articulation. If you have a currently "watched" movie (a track displaying the eyeball icon), then your model articulation 
start and end times will "snap" to the movie's time steps when dragged with the mouse. To turn off the snap function 
temporarily, just collapse the watched movie by clicking on the collapse triangle next to the eyeball. Once collapsed, the 
"watch" status is turned off, and the articulations can be freely dragged on the timeline.  

To edit an existing keyframe, double-click it on the timeline. The keyframe editor will appear. This is the same dialog 
used when adding keyframes.  

  

On this dialog, start and duration can be manually edited, as an alternative to dragging the keyframe with the mouse. 



Below that, the acceleration and deceleration durations are shown as percentages of the total duration. The default for 
both is 50%, causing the motion to gently transition to and from rest at either end. Setting them both to 0% results in 
linear motion (constant velocity), typically including discontinuous velocity at both ends. The combined total cannot be 
larger than 100%.  

On the far left and right sides of this dialog, the "Start Value" and "End Value" sliders are shown. These control the 
position of the model piece being articulated. When multiple articulations are present on the same track on the timeline, 
the "Automatic" checkbox causes later articulations to import Start Value from the previous End Value on the timeline. 
The very first start value, from the first articulation on each track, is used as an initial setting for the model prior to 
encountering any timeline keyframes.  

In the bottom center of this dialog are the repeat settings. An articulation or group of articulations can be set to repeat 
over a range of time. Any subsequent articulations placed downstream from a repeating articulation may become part of 
the repeat cycle automatically, depending on their start time and the end time of the repeat cycle. Selecting "Repeat 
Indefinitely" will guarantee that subsequent articulations join the repeat group. Alternately, selecting "Repeat Until" has a 
default value to allow only a single repeat of the articulation, and careful use may allow later articulations to remain 
separate from the repeat group.  

Articulations that are in a repeat group inherit all of their repeat settings from the first articulation in that group. Turning 
off repeat mode for the first articulation in a group turns it off for the entire group.  

Custom intervals  

If an object has it's 2D graphics basic properties set to "Custom Intervals" mode, colors from listed custom intervals will 
be shown in a thin bar across the top of the object timeline. This is especially useful for Astrogator vehicles, since 
Astrogator uses colors to differentiate its segments, and those colors are automatically placed by Astrogator in the custom 
interval list. In other words, when you click the "Go" button in Astrogator, your segment colors will be immediately 
reflected on your vehicle's object timeline.  

Troubleshooting  

Installation problems  

If the Movie Timeline toolbar is not visible in the list of available toolbars, check the STK Message Viewer for any 
"plugin" error messages that may have appeared on startup. Make sure you are running at least STK version 9, and the 
plugin has been installed. If you're certain the plugin is correctly installed, launch STK and click on Edit->Preferences, 
and look for a section called "Manage Ui Plugins."  



  

On the bottom half of the above screenshot, there is a "Reset Toolbars" button. Try clicking this button (with the Movie 
Timeline plugin selected in the upper part) to restore the default toolbar for the plugin.  

Connection problems  

The image in the previous section also identifies a small button that provides access to some internal settings within the 
Movie Timeline plugin. If you click it, you see a window similar to the one below.  

  

The "Verbose Viewer Message Log" can be set to "true" to see a detailed log of communications between the plugin and 
STK in the Message Viewer window.  

NOTE: Turning on this setting will hurt the overall performance of the Movie Timeline plugin, and of STK itself. The 
setting may remain switched on in future STK sessions, even if you don't "set as default," until you manually turn it off 
again. 

The verbose log is a good way to look for errors, malformed commands, or other communications problems between 
STK and the plugin. For example, if your timeline uses a Stored View that has been deleted or renamed in STK, errors 
will crop up here.  



Remember to turn it off once the issue has been resolved, to improve performance.  

Other issues  

For additional help, visit the AGI discussion forums: http://www.agi.com/agiforum/viewtopics.cfm?Forum=57  

Movie Timeline v2.0, 12 Nov 2009 

http://www.agi.com/agiforum/viewtopics.cfm?Forum=57

